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Introduction

Papyrus is a bibliography management package supplied by Research Soft Design of Portland, Oregon, USA.  It is site-licensed by the University (Reference E gives details of the licence agreements, registration procedure, and how to install Papyrus).

Papyrus stores references in a database, can search the database to locate the references you want for a particular bibliography (list of references), and can produce the bibliography in the style required by a particular publisher, journal editor, or institution.  It can also scan the text of an article or thesis for citations and generate the corresponding bibliography.

This document shows how to type references into Papyrus, list the references (for example for checking or printing), and edit them.  The focus is on basic concepts and techniques required to get started using Papyrus.  Reference B follows on from this document and shows how to prepare bibliographies to publication standard.

This document does not describe all the bibliographic conventions you may encounter, and Papyrus itself has little on-line help.  It is strongly recommended that you also read the ‘Concepts’ sections of Reference A.

How to use this document

The practical work in this document uses a pre-prepared example Papyrus database which is already installed in Computing Service training rooms.  If you are using this document elsewhere then obtain the example database and install it on the computer you are working with (Appendix C shows how to do this).

Read through the document.  Whenever you encounter a chevron (() then these are instructions that you should carry out on the computer.

Please use the examples as shown, rather than typing references of your own devising as some of the subsequent practical work relies upon previous examples.

Windows and the mouse

This document describes the use of Papyrus from within Windows and in conjunction with the Word for Windows wordprocessor.  Papyrus can also be used from DOS and in conjunction with DOS wordprocessors, for example Word 5.0 (for further details see References C and E).  Whether used from Windows or DOS, Papyrus can be used with or without a mouse, or with a combination of the mouse and keyboard shortcuts.

Papyrus was not originally designed for use with a mouse.  In places Papyrus is similar to a Windows application, but do not expect the mouse always to operate exactly as it does in Windows (for example you cannot highlight a section of text by clicking-and-dragging).  In other places the mouse is of little help.  The mouse is very sensitive on NT, but unlike Windows 3.1 there is no distinction between a DOS mouse and a Windows mouse, so there is no need to install a DOS mouse driver. To make the mouse slower, press Alt-Enter after opening Papyrus. This will run Papyrus in a window rather than in full screen mode. This is more effective than trying to change the mouse speed.  This document starts by using the mouse, but describes the equivalent keyboard methods and encourages their use.

Starting Papyrus

In Computing Service training rooms:

(
From the Start button, choose Programs/ Papyrus.

Main menu

When Papyrus starts the Reference menu is displayed, usually called the Main menu.
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References are stored in a Papyrus database, which is a collection of files of file type BIB.  It is possible to have more than one database on a PC so long as each database is in a separate directory.  As it starts, Papyrus looks for an existing database; the directory it looks in depends on how Papyrus has been set up and how it is started (Reference E).

In Computing Service training rooms Papyrus looks in the directory F:\USER\PAPYRUS, where there is a small example database.  At the bottom of the screen is shown the location of the database and the number of references in it (currently 24).

To choose an option from a menu, click on it; or use the arrow keys to move the highlight and press Enter when the option is highlighted.  Alternatively, type the capitalised letter of the option’s name, for example G for Group, but O for glOssary (to distinguish it from Group).

Enter and Esc

The Enter key always accepts something, for example the currently-highlighted menu option, the default or displayed answer to a question or prompt (request for more information), the contents of a field (explained below) or dialog box.  Press Enter to move on to the next operation, prompt, or field but do so only when what is highlighted, typed, or displayed is correct.
The Esc key returns to a previous menu or screen.  From anywhere in Papyrus pressing Esc enough times always gets back to the Main menu.  It is also the way out of most things without changes being made (for example it cancels an inadvertently-summoned screen or menu, abandons input without saving, and cancels operations without making changes).

F1 (Help)

The F1 key gives help; this is brief and very limited, but may be useful as an aide-memoir.  From any menu, F1 summarises the available options:


From the Main menu, press F1.


Press the Esc key to cancel the help screen.

At certain other places in Papyrus, F1 gives a summary of the actions of various keys.  Little other help is available (but nothing is lost by pressing F1 at any time to see what is there).  Esc always cancels a help screen.

Introduction to List

List displays references in the database on the screen (for example for checking).  It also prints lists of references (if Papyrus has been set up to work with the printer; Reference E) and produces files of references that can be incorporated into an electronic mail message or wordprocessed document.


From the Main menu, choose List.  The List menu is displayed.

To display all the references on the screen in alphabetic order of author:


From the List menu, choose Alphabetic.


When prompted for which author to start with, press Enter to accept the suggested Beginning (alphabetically first author).


When prompted for which author to stop with, press Enter to accept the suggested End (alphabetically last author).


A format for the list is suggested (reference formats are explained below).  Press Enter to accept the suggested Standard format, with lengthy abstracts and keywords truncated (cut short).


When asked for the list destination, press Enter to accept Screen.


Some references are listed.  The number to the left of each reference is the Papyrus Reference Number (explained below).  Press any key to see more references, and continue until returned to the Main menu.

Introduction to Input

Input adds new references to the database.  The following reference will be input.

Stone,A (1994): Geomorphology. Pergamon Press, New York.


From the Main menu, choose Input.  The Reference Input/Edit screen is displayed.
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At the top is a Menu Bar.  Four menus are available; Reference, Edit, View, and Type.  The Type menu is open.  Reference types are explained below; for the moment just note that this is a reference to a book.


From the Type menu, choose Book.

A reference can be split into distinct items of information, for example the name of the author, date of publication, title of the work, etc.  Each item of information is stored in the database in a separate ‘field’.

The first field is for the reference number (# stands for 'number').  Each reference must have a unique number, automatically supplied by Papyrus.

The cursor is positioned for typing the name of the first author.  To correct typing mistakes use the Backspace key.


Type the name of the author exactly as:


Stone,A


and press Enter.  Another field appears, for the name of a second author, and the cursor moves into it.


There is only one author so leave this Author #2 field blank (just press Enter).


Type the year of publication, as:

1994
(and press Enter)


In the Yes/No field Authors” are editors?, press Enter to accept the default suggestion, N.  (The purpose of this field is explained in ‘Authors and Editors’ on page 14).


Type the title of the book as:


Geomorphology

This reference has no edition or volume number, so press Enter until the cursor reaches Publisher.


Type the name of the publisher, as Pergamon Press (press Enter).


Type the city of publication, as New York.

The reference must now be saved.  Save is an option on the Reference menu.


In the Menu Bar, click on Reference.  The Reference menu opens.


Click on Save.  The Type menu opens in anticipation of another reference.

Reference Types

A reference is a pointer to another work and should contain enough information for a reader to locate the work referred to.  Certain information should always be supplied (for example name of the author, year of publication).  Other information varies with the type of work referred to.  Appendix A gives examples of four types of reference.

References to journal articles quote the name and volume number of the journal, whereas references to books quote the name of the book and the publisher’s details.  References to chapters in books quote both the name of the book and the title of the chapter (and usually also the page numbers of that chapter).  Chapters in books are often authored by people not responsible for the entire book (the editors).  Theses are different again.


From the Type menu, choose Chapter.  The fields now available differ from those for an entire book.

Papyrus recognises eight types of reference: Article (in a journal), Book (entire), Chapter (in a book), Map, Patent, Thesis, Quote, and Other.  References not obvious on the Type menu (for example conference proceedings and reports) can usually be accommodated by judicious use of the available types.  Types Quote and Other are very rarely used.  Quote is for references that cannot be input in full because their existence can only be documented via another reference (used mainly for obscure or ancient references).  Other is for references that cannot be fitted into any other reference type (for example personal communications, interviews).


Open the Type menu again (in the Menu bar, click on Type).


From the Type menu, choose Article.


Confirm you want to change reference type (click on Yes, or type Y).


Examine any other reference types that interest you.

Consult Reference A (pages 79-85) before attempting to input references not obviously on the Type menu, and before using Quote and Other.  Other is a last resort, the reference is stored as free-form text and this makes it hard to work with and format for publication in a bibliography.


Press Esc to return to the Main menu.

Reference Formats

There are now 25 references in the database.  To check the reference just input:


From the Main menu, choose List.


From the List menu, choose Numeric (list in order of reference number).


When prompted for the reference number to start at, type:


25
(and press Enter)

Accept all other suggestions (press Enter until reference is displayed).

 
Examine the reference.  It contains punctuation and spacing you did not type, supplied by the Standard list format.


Return to the Main menu.

References appear in print in many different styles, depending on the preferences of the publisher.  Below are some examples:

Nature
1.
LaFièvre, H. New Engl. J. Med. 182, 254-267 (1992).

2.
Geomorphology (Stone, A.) (Pergamon Press, New York, 1994).

American Journal of Sociology
LaFièvre, Henri. 1992. "A Survey of Holistic Medical Practices." New England Journal of Medicine 182:254-67.

Stone, A. 1994. Geomorphology. New York: Pergamon Press.

The Drama Review
LaFièvre, Henri

1992     
"A survey of holistic medical practices." New England 


Journal of Medicine 182:254-67.

Stone, A.

1994     
Geomorphology. New York: Pergamon Press.

The order of fields and the punctuation between fields may vary; names may be full or abbreviated; some fields may have special styling (such as bold or italic); differing text may be used (such as ‘eds’ or ‘Edited by’); some fields (for example title) may be omitted, and so on.

Regardless of how a reference appears in the source from which you are typing it, and regardless of how it is finally to appear in print, Papyrus needs references to be input in a certain standard way.  Later, when references are printed or transferred to a wordprocessor, stylistic details are supplied by the list format (output format) selected at that time.

Papyrus has two in-built formats, Standard and Brief.  Many other output formats are available in the Format Libraries supplied with Papyrus.

Standard format

Standard format is unlikely to be acceptable to a publisher but, because it shows the contents of all the fields in a reference, it is the best to use for examining and checking references (on the screen or as a printed list).

Brief format

Brief format is used when you are interested in which references are in the database but do not need all details of these.


List all the references alphabetically.


When asked if the suggested list format is Okay, type N.


When prompted for the name of a format type:


brief


List on the screen, then return to the Main menu.

Library formats

Library formats are used to prepare bibliographies that meet the stylistic requirements of a particular publisher.  To use a library format it must first be copied into Papyrus (Reference B shows how to do this).  In this database the format for the journal Nature has already been copied.

List all the references alphabetically.


When prompted for a format, type:


nature

List on the screen.

Fields to have special styling when printed are enclosed in ‘braces’, the style is shown by the character immediately following the opening brace:

{i...}  italics.
{iComp. & Struct.} 
prints as Comp. & Struct.
{b...}  bold.

{b41}


prints as 41

Shortly it will be seen how the style is automatically applied when a list of references is transferred to a wordprocessor.
The numbers to the left are not Papyrus reference numbers.  Nature numbers references in the order they appear in the bibliography.  The punctuation, spacing, and order of fields differs from Standard format.  Some fields are omitted (for example Nature does not print titles of journal articles).


Return to the Main menu (Esc will interrupt listing).

Listing references for Word for Windows


List all the references again, alphabetically and in Nature format; but as the list destination, choose File.


As the file type, choose Microsoft Word.


Change the suggested filenanme to F:\USER\PAPYRUS\BIBLIO.DOC.  Do not accept the suggested filename (F:\USER\PAPYRUS\BIBLIO.LST) because it can be confusing. It is better to give the file type as .DOC so that Windows NT knows it is a Word document. 

Task switching in Windows

With Windows more that one program can run on the PC at the same time (for example Papyrus and Word) and you can switch between the programs without quitting from them.  One way to do this is described here (Reference F gives further details and other methods).

To start Word for Windows (in Computing Service Training Rooms):


From the Start button choose Programs/ Word 

To open the file in Word for Windows:


From the File menu, choose Open.  The Open dialog box is displayed:


In Look in, select F:\USER\PAPYRUS.

By default only files of type DOC are displayed.  (if you did save the file of type LST: In Files of Type, change  *.doc  to  All files  and then click on Open).


Click on BIBLIO. and then click on Open.

Note, for instance, that journal names are in italics and the volume number in bold.  The references are in a non-proportional font (Courier).  When preparing a bibliography, use the wordprocessor to adjust the font, margination, and indentation.


Find the reference you input earlier (it is number 20 in the list).  Note that the order of the fields is very different to the order in which you typed them into Reference Input/Edit.


Return to Papyrus by pressing the Papyrus button at the bottom of screen.  (If you are running Papyrus full screen and you want to switch back to Word, keep the Alt key held down and press Tab repeatedly.  The names of currently running programs are each shown in turn.  With Word displayed, release the Alt key.)

Rules for names

Papyrus stores the names of authors and editors in a standard way, as:

Surname,X

'X' may be an initial, initials, full first names, or a combination, for example:

Holmes,S
Jung,CG
Morton,Susan
Einstein,Albert P
Picard,J-L

As long as this basic rule is followed, Papyrus is tolerant about the exact way a name is typed.  Names may be typed in lowercase, with or without full-stops after initials, and with or without insignificant spaces.


Start to input a reference.  Choose Book.


Type the authors’ names exactly as shown below (in lowercase, including any spaces and full-stops).  Press Enter after each name and notice how Papyrus adjusts what you type:

holmes,  s.
jung,  c.  g.
morton,  susan
einstein,  albert  p
picard,  j-l
Clearly it saves effort to type names in lowercase, without full-stops or unnecessary spaces.

Always type the fullest name known; some publishers use full names in bibliographies, others don’t.  The output format decides which to use when a bibliography is prepared (for example Morton, Susan or Morton,S).

If the surname is hyphenated (Ashton-Tate), has apostrophes (O’Connor) or has spaces in it (de Costa), Papyrus asks how to alphabetize the name:


Type another author, as:


moore-o’farrel,t

If alphabetized as Moore-O’Farrel, when listed alphabetically the name appears among authors whose names begin with the letter ‘M’.  If alphabetised as O’Farrel it appears among authors whose names begin with ‘O’.  If Farrell, among ‘F’.


Alphabetize as Moore-O’Farrel.


With this reference still on the screen, read on.

Mouse and keyboard in Input/Edit

This section describes some mouse and keyboard conventions in Reference Input/Edit.

Using the Menu Bar

Reference Input/Edit is the part of Papyrus most similar to a Windows application.  To open a menu from the Menu Bar, click on the menu’s name.  Alternatively hold down the Alt key and type the capitalised letter of the menu’s name (eg Alt/R for the Reference menu).


Open the Reference menu.

Once a menu is open an option can be selected from it as follows.  Either click on the desired option, or use the up and down-arrow keys to highlight the option and then press Enter, or type the capitalised letter of the option’s name (eg S for Save).

To the right of each menu option is a keyboard shortcut which allows selection of a menu option without the need to open the menu.  Thus an alternative to selecting Save is Alt/S (hold down the Alt key and press S).  An alternative to selecting Cancel (abandon input of this reference) is to press the Esc key.  An alternative to selecting Help is to press the F1 key.

Using keyboard shortcuts will speed the use of Papyrus.  Also several options are available in parts of Papyrus that do not have a Menu bar.  It is therefore recommended that you get into the habit of using the keyboard shortcuts.

To close a menu click anywhere outside of the menu, or press Esc.


Close the Reference menu.

Keyboard help (F1)

In Reference Input/Edit, press F1 at any time for a summary of the actions of various keys (some of which are explained in more detail below).  These are also summarised in Appendix B.


Press F1, then press Esc to cancel help.

Input and editing of fields

This section describes some conventions and techniques for typing information into reference fields and altering the contents of fields.  Some useful shortcut features are also described.  A chance is given to practice these in ‘Examples’ on page 12.

Moving between fields in a reference

Enter, Tab, or the down-arrow key move the cursor down through the fields in sequence and accept the entire contents of a field regardless of where the cursor is positioned in the field at the time.  Fields can be skipped; just leave the field blank.

To move back up to a previous field use Shift/Tab (ie hold down the Shift key and press Tab), or the up-arrow key.

Alternatively, just click in the required field.

Moving within a field

The cursor can be positioned at any point within a field by clicking there.  Alternatively, use the left and right arrow keys.

Word-wrap

Avoid pressing Enter when typing a long field such as a lengthy title, abstract, or comment.  Like a wordprocessor, Papyrus automatically word-wraps on reaching the right-hand edge of the screen.

To force a new paragraph

To start a new line in any field (for example for clarity in long abstracts or comments) use Ctrl/Enter (hold down the Ctrl key and press Enter).

Copy (F3) and Paste (F4)

Like Windows, Papyrus has a clipboard and the contents of a field can be copied to the clipboard and then pasted into another field.  (If using Papyrus from Windows, Copy and Paste use the Windows clipboard and allow items to be transferred to and from Windows applications).

Although PAPYRUS can directly access the clipboard in Windows 3.0, Windows 3.1, and Windows 95, it cannot get to the clipboard used by OS/2 or Windows NT. Go to the Preferences option and pick the "OS/2, NT clipboard" option. This lets you designate a disk file for PAPYRUS to use in place of the Windows clipboard. Once you have entered a filename under "OS/2, NT clipboard", all references to the Windows clipboard will instead be directed to this file. Do be careful to specify the directory as well as the name else it will end up in the root directory. The default name is clip.txt. 

Copy and Paste are available from the Menu Bar (Edit menu); but are also useful where there is no Menu Bar, so it is best to learn the keyboard shortcuts:

F3
Copy a field to the clipboard

F4
Paste the current contents of the clipboard into a field.

Copy and Paste work within a reference and between references.  A new item copied to the clipboard file over-writes previous contents.  Entire fields are copied (unlike Windows, click-and-drag cannot be used to highlight part of a field for copying), but it may still save effort to copy/paste a field and then edit it (F5 and F6, described below, can quickly shorten a pasted field).

Editing fields

To amend the contents of a field, first position the cursor (by clicking, or using the arrow keys).

· The Backspace key removes the character to the left of the cursor.

· The Delete key removes the character at the cursor’s position.

· The Ins key toggles between Insert and Overtype (Insert is the default).

Erase backwards and forwards (F5 and F6)

To quickly shorten the contents of a field, or completely clear it, use:

F5
Erase backwards (from the cursor to the beginning of a field)

F6
Erase forwards (from the cursor to the end of a field).

Special characters (F10)

F10 gives a table of ‘extended ASCII characters’.  It is used to insert characters not available on the keyboard (for example accented characters).

Examples

Use the keys described above to complete this exercise.  Remember that F1 gives a keyboard reminder.


Change the contents of the Authors are Editors? field from N to Y (it does not matter if this is uppercase or lowercase).


Type the title as:


Demographic statistics: Mobility, housing and health in Europe 1950-1980


With the cursor in the Title field, copy the title to the clipboard.


Paste the contents of the clipboard into the Abstract field.


In the Abstract field, position the cursor on the colon (:) then erase everything forwards from the cursor.


Complete the abstract so that it reads exactly as shown below, including the blank line.


Demographic statistics, including:


Population
Mortality


Type the publisher as:


University of Bristol


Copy the name of the publisher to the City of Publication field.


In the City of Publication field, position the cursor on the ‘B’ in ‘Bristol’ and erase everything backwards from the cursor (so that the field contains just the single word Bristol).


In the Comments field, type the phrase:


Mal à tête


To do this, type as far as the first accented character (à) and then display the table of extended ASCII characters.  Select the required character from the table by clicking on it (or use the arrow keys and Enter).  Repeat for the second accented character (ê).


Press Esc to discard this reference without saving and return to the Main menu.

Guidelines for the input of references

This section gives tips for the most frequently-used reference fields.  Reference A (pages 67-85) gives further guidelines.

To illustrate, some references will be input.  The first is:

Rent,E; O’Kille,R; et al. (1990):  Distribution, Migration and Habits.  In:  Rattus rattus and Related Rodents in Europe and the U.S.A. 2nd ed. Vol. 1. (Eds: Farmer,Ivor P;  Towne,Tony) Prentice Hall, Englewood Cliffs, NJ, 17-32.

General

First decide the reference type.  Although this can be changed at any time, it is best to get it right from the start.


Start to input the above chapter.

Fields shown in white are required; if these are left blank the reference is treated as incomplete (see below).  Fields in yellow are optional.

Regardless of how the reference appears (or is to appear in print), input the reference in a standard way.  Don’t worry about details such as punctuation and spacing between fields and special styling (for example italics, bold); these can be supplied by the chosen output format.

With the exception of the special cases below, type the material exactly as it is later to be printed.  Don’t be lazy about names, punctuation, and spacing within fields, or capitalisation of proper nouns.

Regardless of the order of the fields in the source from which you type the reference, it is easiest to input the fields in the order they appear on the screen, using Enter (or Tab) to move down through the fields in turn.

Reference number

Each new reference is given a reference number 1 higher than the highest currently in the database.  This can be changed, but it is best to accept the suggested number.

Author names

Up to 99 authors are allowed per reference.  Author #1 is mandatory, the reference cannot be saved if this is left blank.  Input authors in the order they appear in the reference, one per author field, as:

Surname,X

Input all known authors.  Publishers differ in the number of names printed before ‘et al.’ is used; the chosen output format decides whether to use ‘et al.’ in bibliographies and how many names to print before it.


Type the names of the authors (as rent,e and o’kille,r).  The remaining authors are not shown in the source from which you are typing.

Names not known, and et al
If some authors’ names are not known, input all that are known and use et al as the last author.  (See Reference A for special cases, such as ‘anonymous’ and ‘corporate’ authors).


In Author #3 type et al (a full stop is supplied on pressing Enter).

References with et al are saved with the special keyword INCOMPLETE (see ‘The keyword INCOMPLETE’ on page 17).

See Reference A for special cases of names not know, such as ‘anonymous’ and ‘corporate’ authors.

Authors and Editors

Some books are written by the authors, others are edited works (see ‘Books’ in Appendix A for examples).

For references of type Book the Yes/No field Authors are Editors? is used to distinguish between the two possibilities.  If set to Y the chosen output format will supply suitable text, such as ‘Eds.’ when the book is listed.

With references of type Chapter, Papyrus assumes an edited work and makes available separate fields for the names of the editors (see ‘Editors’ on page 15).

Year

Papyrus assumes that most references are from the current century, so the last 2-digits of the year are sufficient.


Type the year as 90.

(If this would result in a date more than 2 years into the future, the last century is assumed.  If there are two references by the same author with the same year avoid typing, for example 1989a, 1989b).

Year not known (In press, etc)

Year is mandatory.  If a work has not yet been published, for the year type, as appropriate, In press, Submitted, or In preparation.  Such references are saved with the keyword INCOMPLETE.

Titles

Titles can be up to 8,000 characters.  Type titles in sentence style (Distribution, migration, and habits) rather than title style (Distribution, Migration, and Habits) regardless of which style is used in the source from which you are typing.  The output format re-capitalises titles to the style required by the publisher.  However, proper names, abbreviations, acronyms, etc, should be correctly capitalised.


Type the chapter title, as:


Distribution, migration, and habits

Forcing special styling

It is normally left to the output format to apply special styling (such as italics and bold) to selected fields when references are listed.  No special action need normally be taken during input to ensure this.  Sometimes, however, special styling may be required regardless of the rules of the output format, eg you may wish Latin names such as Homo sapiens always to appear in italics even if the rest of the title is printed in normal text.  To force special styling, enclose the word(s) to be styled by braces; the style required is indicated by the ‘control character’ immediately following the opening brace (eg {i...} means italic).


Type the book title (in sentence style, but with proper names and abbreviations correctly capitalised) as:


{iRattus rattus} and related rodents in Europe and the U.S.A.

Forcing a full-stop at the end of a title
Notice that a full-stop at the end of a title is automatically removed upon pressing Enter.  If the title really should end in a full-stop, precede the full-stop with a brace.


Add a brace and full-stop to the end of the book title:


Industrial trends in Europe and the U.S.A{.

The brace is not printed in bibliographies.

Edition

If input as digits only, Papyrus expands this (for example 2 becomes 2nd).


Type the edition as 2
Volume

Input as digits only (the output format can add text such as Vol).


Type the volume as 1
For journals it is sometimes necessary to supply information to supplement the volume number (for example an issue number or date of publication).  See ‘Routinely Cite’ on page 19.

Editors

Chapter type only.  Up to 99 editors are allowed per reference.  Leave Editor #1 blank if the chapter is from an authored book.  Input in exactly the same way as author’s names (including et al if necessary).


Type the names of the editors (as farmer,ivor p and towne,tony).

Publisher and City

Must be correctly capitalised and punctuated.


Type the publisher’s name as Prentice Hall


Type the city of publication as Englewood Cliffs, NJ
Page(s)
Page numbers can be the starting page number (for example 17) or a range separated by a dash (for example 17-32).  Give the range if known; the output format decides whether to print the range or just the starting page.


Type the page numbers as 17-32
Abstracts and Comments

Can be up to 8,000 characters, otherwise use Notecards (Reference A).

An Abstract is a summary of the work.  The Comment field is for your own comments.  Neither is normally included in a printed bibliography.

Remember to use Ctrl/Enter (not Enter) to insert line breaks for clarity in long comments and abstracts.

Keywords

Keywords allow searches of the database for references pertaining to particular topics.  If you use keywords make them up yourself based on those aspects of the reference most relevant to you.

Up to 99 keywords are allowed per reference.  Papyrus is case-insensitive to keywords (it automatically capitalises them).

Keywords can be single words or phrases; those that differ only in punctuation are considered identical, for example BIOLOGY HUMAN vs BIOLOGY, HUMAN vs BIOLOGY - HUMAN (Preferences can be used to make punctuation significant; see ‘Preferences’ on page 27).

Putting  #  in front of a keyword (for example #TRANSPORT) designates it as a ‘major’ keyword for that reference.  The database can be searched for either (1) references with a particular keyword regardless of whether it is major or minor for that reference, or (2) only references for which the keyword is a major one.  (See also pages 25-26 of Reference A).


For Keyword #1, type as a major keyword:


#transport

New keyword?

Papyrus asks if this is indeed a new keyword (to be added to the Keywords Dictionary), as opposed to it being a mis-typing of a keyword it should already know about (already in the Keywords Dictionary).

Keywords are not saved with each reference, but are held in a separate Keywords Dictionary.  (A ‘pointer’ to the Keywords Dictionary is saved with the reference).  A consequence of this is that if a keyword in the dictionary is changed then all references with that keyword are effectively updated accordingly; see ‘Editing the keyword dictionary’ on page 26.


Confirm this is a new keyword, by pressing Enter (Enter accepts the answer shown with a double-border) or clicking on Yes.


Input another keyword, this time a minor one:


industrial development


To stop prompting for additional keywords, leave the last-offered keyword field blank (press Enter).


Confirm that you want to save the reference.  Papyrus offers to add the keyword INCOMPLETE.  Before responding, read on.

The keyword INCOMPLETE

If any ‘required’ (white) fields are left blank, Papyrus offers to add the special keyword INCOMPLETE.  This keyword is also added in two special cases described above, ‘et al.’  and ‘year not known’ (the current reference has ‘et al.’).  

References with the keyword INCOMPLETE are marked as such when the reference is listed, and the database can be searched for incomplete references (for example to help in gathering the missing information).


Save the reference with the keyword INCOMPLETE.

Note:  When missing information is later supplied it is necessary to manually remove the keyword INCOMPLETE.

Journal articles

The following journal article will be input:
LaFièvre,Henri (1992):  A Survey of Holistic Medical Practices.
New Engl. J. Med. 182,  254-267.


Start to input the article. Note that the author’s name has an accented character.  Note also the unusual capitalisation of this name.  Remember to type the title in sentence style.  On reaching the Journal field, stop and read on.


Type the name of the journal in the abbreviated form shown in the reference (Papyrus later asks for the full name).  Include capitals and full-stops:


New Engl. J. Med.
New journal?

As with keywords, details of a journal are held in a Journals Dictionary (a pointer to the Journals Dictionary entry is saved with the reference).


Confirm that this is a new journal (to be added to the Journals Dictionary).  The Journal Input/Edit dialog box appears.

Journal Input/Edit Dialog Box
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This dialog box requests more information about the journal.  Some bibliographies use abbreviated journal names (Standard Abbreviations), while others use the journals’ full names.  To prepare bibliographies for different publishers, Papyrus needs to know both abbreviated and full names.  It also needs to know how to ‘Routinely Cite’ the journal (explained below).

Pressing Enter will accept the contents of a dialog box.  Therefore don’t press Enter until satisfied with the contents of all the fields in the dialog box.  If Enter is pressed prematurely, complete the reference and then use the Journal option from the Main menu to re-display the Journal Input/Edit dialog box, as described in ‘Editing the journals dictionary’ on page 25.

To move the cursor between fields of a dialog box either click in the desired field or use Tab (next field) and Shift/Tab (previous field).  The behaviour of Enter in dialog boxes can be disconcerting if you are in the habit of using Enter to move to the next field of Reference Input/Edit.  If this causes problems either use Tab to move through Reference Input/Edit, or change the action of Enter in dialog boxes (see ‘Preferences’ on page 28).


Papyrus has guessed that New Engl. J. Med. is an abbreviation and has inserted this as the Standard Abbreviation.  Supply the journal’s full name:


New England Journal of Medicine

For this reference leave all three Routinely Cite fields set to N.


When satisfied with the contents of the dialog box, press Enter (or click on Okay).  The full name is now shown in the Journal field.


Input the volume number (182) and pages (254-267).


Save the reference (Alt/S).

Routinely cite?

Most journals use continuous page numbers throughout each 6 or 12 month volume, so to locate an article it is normally sufficient to give just the volume number and a page reference.  However some journals restart every issue with page 1.  For these it is necessary to give an issue number.  With popular magazines such as National Geographic and Psychology Today the issue number may not be obvious, so the month or date of publication may need to be given.  Sometimes a journal is split into separate series (for example Physics Letters A and Physics Letters B).  To accommodate all these cases, Papyrus can make available the additional fields Issue, Day & Month, and Series.

Rocke,AS; Roal,ND (1990): Music and the mind. Psychology Today 35(May), 16-20. 


Input the above journal article.  Type the journal name as:


Psychology Today


Supply a standard abbreviation (Psychol. Tod.).


Tab to (or click on) Day/Month?, then press (or click on) Y.


Accept the dialog box.  Reference Input/Edit now has a field called Day & Month.


Type the volume number (35)


In the Day & Month field, type May.


Type the page numbers (16-20).


Don’t save the reference yet, but read on.

Hidden fields

Day & Month is an example of a ‘hidden’ field (to avoid cluttering the screen some infrequently-used fields are not normally displayed).  To store information that doesn’t fit easily into one of the usual fields use one or more of these hidden fields.

Displaying hidden fields

Show hidden fields is an option on the View menu.  The keyboard shortcut is Alt/H.


Display the hidden fields.

Some hidden fields are specialised for a particular reference type.  Others are available to all reference types, for example:

Also Print
Information to appear at the very end of a reference when printed (for example the language in which the reference is published, or the name of a translator).

Accession No
A local or universal library code number.

Location
Local location information (for example ‘Box File 7).

Affiliation/

Address
Author’s institutions and/or addresses


In Also Print, type:


Translated by A. Drummer

Fields A, B and C

As well as meaningfully-named fields, three fields (Fields A, B, and C) are available to use for whatever you like.  For instance, you might wish to record the language from which the reference was translated.


In Field A, type:


French

Caution: Papyrus uses indexes to speed searches.  Only Field A is ‘indexed’, therefore do not use Fields B and C to hold information that may later be searched for, or the search is very slow.

Preferences can be used to give Fields A, B and C more meaningful names, and also to force any hidden field always to appear in Reference Input/Edit (see ‘Preferences’ on page 28).

Hiding fields

Show hidden fields (Alt/H) is a toggle; that is, if used when hidden fields are not displayed it will display them, and if used when they are displayed it will hide them again.

Hide the hidden fields.  Only blank hidden fields are removed from view.


Save the reference (Alt/S) and return to the Main menu.

Input shortcuts

Papyrus has many shortcut methods to speed input and avoid repetitive typing.  This section describes some of the most useful of these.

The Glossary

The glossary is used to store frequently-used words or phrases, which later can be inserted into a reference or in answer to a prompt.  This avoids the need for repetitive typing of similar information and helps avoid mis-typing or spelling mistakes.  Major publishers and cities of publication are obvious candidates for the glossary.  (Note: the glossary is not normally used for authors’ names, editors’ names, journal names, or keywords.  Papyrus has other ways to deal with these).

In this example database some items are already in the glossary:


From the Main menu, choose Glossary.


From the Glossary menu, choose List.  Display the glossary on the screen.

To add items to the glossary:


From the Glossary menu, choose Input.


When prompted for an Entry, type:


Academic Press
(and press Enter)
neurosurgery

(and press Enter)
toxic stress

(and press Enter)


Press Esc to return to the Glossary menu.

From the Glossary menu, Edit corrects mis-typed glossary items and Delete removes unwanted ones.


Return to the Main menu.

Inserting from the glossary

When a reference is input, use Look Up to insert relevant items from the Glossary.  Look Up is an option on the Reference menu, but is useful also where there is no Menu Bar, so it is best to learn the shortcut key (F2).

Wrigley,IM;  Twitch,E (1994): Toxic stress: Symptoms and indicators one week after surgery.  In: Advances in neurosurgery. 4th ed.
(Ed: LaFièvre,Henri)  Academic Press, Chicago,  123-145.
Keywords: #TOXICITY; #SURGICAL MEDICINE


Start to input the above chapter.  Stop at the Chapter Title.


In the Chapter Title field, press F2.  When prompted, press Enter for a list of glossary items.

An item can be selected from a Look Up list by clicking on it.  However the mouse can behave erratically when used with lists so it is probably easier to use the up and down-arrow key and Enter.


Select toxic stress.


Complete the title.  Remember to go back and capitalise the ‘T’ in ‘Toxic’.  (Tip: The Home key jumps the cursor to the start of a field, and the End key to the end of a field).


At the book title, type Advances in (and a following space), then insert neurosurgery from the glossary.  (Tip:  When asked to type the first few characters, type n).


Continue with the reference.  Insert the publisher from the glossary.  Before typing the city of publication, read on.

Alternative way to add items to the glossary

Chicago is not in the glossary but is an obvious candidate.  Items can be added to the glossary during input of a reference.


In the City of publication field, from the Edit menu choose Add to Glossary (shortcut: Alt/G).  The Glossary Entry dialog box appears.


Type the new glossary entry (Chicago) and accept the dialog box.  Now insert Chicago from the glossary.


Complete and save the reference.

Look Up (F2)

Look Up (F2) can save a lot of typing.  It is context-sensitive, as follows:

Field

F2 looks up
Author fields:
Names of authors already saved in the database.

Editor fields:
Names of editors already saved in the database.  Note: This lists names previously entered as editors; names previously input only as authors will not be in the list.

Journal field:
Journals in the Journals Dictionary.

Keyword:
Keywords in the Keywords Dictionary.

All other fields:
Glossary.

F2 is also available (and context-sensitive) to answer prompts, for example when listing references.

If a list is inadvertently started at the wrong point, use the mouse or arrow keys to scroll through it.  Alternatively, with the list on the screen, type any character(s) to re-start the list at that alphabetic point.
If a list does not contain anything useful, Esc cancels it.  Even if no existing item is exactly what is wanted it may save effort to insert a close match and then edit it.


Input and save the following article.  Use F2 for all the fields listed below and consult the tips.

Twitch,E; Wrigley,IM  (In press): Neurosurgical aspects of post-operative toxic stress.  New Engl. J. Med.
Keywords: #TOXICITY; SURGICAL MEDICINE

Author #1
See what happens if you type t in the author field and then press F2.  Use this technique if preferred (with any Look Up).

Author #2
For a ‘direct hit’, type the first two characters (wr).

Title
The glossary contains three useful items, one of which needs minor editing.

Journal
It makes no difference whether the full name or abbreviation is inserted.

Keywords
Note that it is necessary to manually add the  #  in front of major keywords.


Save the reference (with the keyword INCOMPLETE).

Journal and keyword ‘guessing’

For Journal and Keyword fields (only), Papyrus can ‘guess’ from incomplete input; that is, it matches what you type against items in the relevant dictionary and if it finds a reasonable match it inserts the item.


Input and save the following article.  Use F2 for the author and title.  Input the Journal and Keyword fields as described below.

LaFièvre,H  (1995):  Neurosurgery.  Psychol. Tod.  39(August), 12-17.
Keywords: SURGICAL MEDICINE; TOXICITY

Journal
Instead of F2, type psy and press Enter.

Keyword #1
Instead of F2, type su and press Enter

Keyword #2
Instead of F2, type t and press Enter

Previous fields (F7 and F8)

Previous field and All previous fields are available from the Edit menu.  The shortcut keys are F7 and F8.

F7
All previous fields.  Described by help (F1) as ‘fill all remaining answers from last entry’.  Inserts into and downwards from any field the contents of the same fields from the last reference of the same type to be saved.

F8
Previous field.  Described by help (F1) as ‘Repeat last entry’s answer for this field’.  Inserts into a field the contents of the same field from the last reference of the same type to be saved.


Input the following chapter as described below.

LaFièvre,H  (1994): Toxic stress: Symptoms and indicators one year after surgery.  In: Advances in neurosurgery. 4th ed.
(Ed: LaFièvre,Henri)  Academic Press, Chicago,  146-53.
Keywords: #TOXICITY; #SURGICAL MEDICINE


Look Up the author.


In the Year field use Previous field (F8).  The Year field from the last reference of type Chapter is inserted.


Delete the Year field (use F5).


In the Year field use All previous fields (F7).  The Year field and all fields below it from the last reference of type Chapter are inserted.


Adjust the title and page numbers.


Save the reference and return to the Main menu.

Note how All previous fields might prove particularly useful to input a series of chapters from the same book, one after the other.

Note that these facilities work only within a session; that is, if Papyrus is quit from then previous fields are not available until new references of the appropriate type are input (or existing references edited).

Answering prompts

When references (and in various other places) Papyrus prompts in the style show below to narrow down exactly what you want to do:

Start with: Beginning (
In all cases the default answer shown to the left of the arrow can be accepted, or an alternative answer typed in full.  In addition various shortcut methods can be used to answer prompts.  In the following examples the List option is used to illustrate the shortcuts, but the same principles apply at any prompts (eg when narrowing down to which reference to edit or delete; see ‘Editing references’ on page 25 and ‘Deleting References’ on page 25).

In all the examples below list on the screen.

Using Look Up (F2)


List and check the references just input  (use the Numeric list option and list from reference number 26 onwards).  Reject Nature format and, when prompted for the name of a format, press F2.  Select Standard format.


List alphabetically from author Jackson to author Marks (use F2).

Mouse tip

When answering prompts the mouse cursor is not visible and cannot be used to move the cursor around.  Whenever the mouse cursor is not visible, the mouse acts as follows:

Left-button
Equivalent to Enter.

Right button
Equivalent to Esc.

This can be useful when using the mouse to select from a list as the hand does not have to be removed from the mouse to confirm the inserted answer.  Clicking the left mouse button also accepts default answers and highlighted menu options, so often a series of prompts can be answered with mouse clicks.


Optionally, repeat the above list (Jackson to Marks), but using the mouse instead of Enter.

Partial answers and wildcards

To list references whose author’s names begin with the letter R, through to those whose names begin with S:


List alphabetically.


When prompted for the author to start with, type r


When prompted for the author to stop with, type s
The wildcards  *  and  ? (which mean ‘any character’) can also be used to answer prompts (for example man*).

Repeat last typed answer (F8)

To list just the references whose first author is Twitch:


List alphabetically.  Use F2 to start with Twitch.  Then press F1 to see what other keys are available.  Note the use of F8.


When prompted for the author to stop with, press F8.

Note:  Only one reference is listed, although two references have been input with Twitch as an author.  An alphabetic list shows only references for which the specified author is the first author (Author #1).  Use a Co-Author list to see all references in which a given author appears (see Co-Author on page 27).

Editing references

Edit allows a saved reference to be altered.  In this example an incomplete reference will be completed.


From the Main menu, choose Edit.


When prompted for a reference number or author, Look Up the author Twitch.


When prompted for the year, accept the default Any.

Because there are two references by this author, Papyrus asks for the ambiguity to be resolved by displaying both references and prompting again.


Type the reference number of the article by Twitch that is ‘in press’.


When prompted, confirm that this is the reference you intended.  Reference Input/Edit is displayed.


For this reference supply the missing information, ie the year (1996), Volume (1) and pages (43-47).


Remove the keyword INCOMPLETE.

A reference that has been edited must be re-saved.


Save the reference and return to the Main menu.

Deleting references

Unwanted references can be permanently removed from the database.


From the Main menu, choose Delete.


Delete the reference by the author Stone. 

Note:  The reference number of a deleted reference is not re-used (unless the deleted reference was the last input, for example the one with the highest reference number).

A range of references can be deleted by providing reference numbers separated by a dash (for example 25-32).

Editing the journals dictionary

The journal’s dictionary may need occasional tidying-up; to add new information, correct errors, make changes, or to delete journals that are no longer cited because all associated references have been deleted.  Because details of a journal are held in a dictionary (and not with each reference), updating a Journal’s dictionary entry effectively updates all references that cite that journal.


From the Main menu, choose Journals.


At the Journal menu, press F1 for a brief description of the available options.

List

(
From the Journal menu, choose List and list all journals on the screen.  (F2 or  *  are used for selective listing).

Both the full name and standard abbreviation are shown (three dots means that the information is not present).  To the right the letters D, I, and S indicate the journal routinely includes Day & Month, Issue and/or Series respectively (Reference A).  Also shown to the right are the number of references currently in the database that cite the journal.

Input/Edit

In this example a Standard Abbreviation that was not input at the time the reference was input will be supplied.

(
From the Journal menu, choose Input/Edit
(
Select the journal Information Technology & Libraries (use F2), and confirm this.

(
In the Journal Input/Edit dialog box supply a standard abbreviation (Info. Tech. Lib.).  When finished, press Enter (or click on Okay).

(
When prompted for another journal to edit, press Esc to return to the Journal menu.

Merge

Occasionally minor discrepancies in the way a journal is named in references (or typographic errors) results in two separate journal dictionary entries for the same journal.  This can be corrected as follows:

(
From the Journal menu list the journals whose names begin with J.  Note that there are two entries for the Journal of the ASIS.
(
From the Journal menu, choose Merge.  Papyrus will ask you for the names of the journals to merge.

(
Merge the Journal of the ASIS with the Jrnl of the ASIS.  Refer to the merged journal as Journal of the ASIS; it’s abbreviation is: J. ASIS.  (Tip: just type one letter of the names and choose the correct journal name first).

Delete

When a reference is deleted it’s journal entry is left in the dictionary even if no other references cite that journal.  Delete removes unwanted journals from the journal’s dictionary.

(
From the Journal menu, choose Delete.
(
Delete the uncited journal Geterog. Katal.
To delete all uncited journals, at the journal delete prompt type ?
Editing the keyword dictionary

The keyword dictionary may need to be tidied-up occasionally.  Because keywords are stored in a separate dictionary, updating the a keyword dictionary entry effectively updates keywords in all references that use that keyword.

(
From the Main menu choose Keywords.

List

(
List all the keywords on the screen.  The numbers to the right are the number of references that currently use each keyword.

Input/Edit

(
Now use the Keyword menu’s Input/Edit to change the keyword dictionary entry DATA BASES to DATABASES.

Delete

(
Delete the keyword MATHEMATICAL MODELS and confirm that it is to be deleted from all references that cite it.

Keywords remain in the dictionary even if all references that used them are deleted.  To delete all uncited keywords, at the delete prompt type ?
Further Listing

As well as alphabetic and numeric, various other list options are available.

Co-author

Co-author lists all references that have the specified author in any author field (Author #1, Author #2, etc).

From the List menu, choose Co-author.


List all references co-authored by Twitch.


List by co-author  *  (for an authors list of the entire database).

Keyword Index

If keywords have been used systematically, listing by Keyword Index should show all references pertaining to the specified topic.


List all references with the keyword SURGICAL MEDICINE (use F2, or keyword ‘guessing’, and F8).  When prompted whether to list by major keywords only, accept the default N (list all references with the specified keyword regardless of whether it is major or minor for the reference).


Repeat the list by keyword SURGICAL MEDICINE but this time list only references for which that keyword is major.  Fewer are listed.


List the incomplete references (this can assist in gathering missing information).

Other list options

Listing by Group is a very useful facility, covered in detail in Reference B.  Listing by Processed List will almost certainly never be needed (it is provided to overcome printing problems with a very few printers; for further details see page 129 of Reference A).

Preferences

Preferences is used to change the way Papyrus appears or behaves.


From the Main menu, choose Preferences.  (F1 for a summary).


Optionally, experiment with the colours or turn off the PC’s beep.


To rename the general-purpose hidden fields A, B and C (if you wish), choose Field names.  For the use of these fields see ‘Fields A, B and C’ on page 20.


Choose Hidden/required.  Don’t change anything, but just use Enter and note that fields can be made required, optional, or hidden.  For the use of the hidden fields see ‘Hidden fields’ on page 19.


If the behaviour of Enter in dialog boxes is irritating, choose Enter in dialogs to change this.  This option allows Enter to be set to act the same as Tab (ie to move between fields) and Alt/Enter to act the same as clicking Okay.  See ‘Journal Input/Edit dialog box’ on page 18.


Return to the Main menu.

Ending a Papyrus session


From the Main menu, choose Quit.

Follow-on

This document has covered everything you need to know to start to manually input references into Papyrus, check references, and maintain a Papyrus database.  However it has not shown how to prepare a bibliography suitable for submission to various publishers.  To do this requires an understanding of how to copy Format Libraries into Papyrus and how to create Groups (sub-sets of references).  These topics are covered in Reference B, as are various other useful facilities such as searching for references, importing references in bulk from computerised sources such as the BIDS, and preparing a bibliography whilst writing a document (citing and text extract).

Practice and consolidate the skills learned from this document by starting to input your own references into a Papyrus database.  When confident with this it is recommended that you complete the practical work in Reference B.
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Appendix A  Examples of References

Journal Articles

1.
Jalaludin,B; Smith,W; de Costa,P (1992): Blue-green algae. Medical Journal of  Australia, Vol 156, No 10, pp 744-753
[Keywords: #BLUE-GREEN ALGAE; MEDICAL RESEARCH]


2.
TI:  Conclusions: a consensus statement on growth hormone therapy.

AU:
Rosenfeld-R; Hochberg-Z; Albertsson-Wikland-K; et-al

SO:
Acta-Paediatr-Scand 1990; 367: 177-8

Book

3.
Pevsner,N. & Hubbard,E. (1971): The buildings of England: Cheshire.  (Harmondsworth: Penguin Books)
[Keywords: #ARCHITECTURE, CHESHIRE]

4.
Elizabethan England, 3rd ed., Vol. 2, (eds Fletcher, A. & 
Stevenson, J. (Cambridge University Press, Cambridge, 1987).

Book Chapters

5.
Knox,RP (1991): Catalytic conversion. Chap. 23. In ‘Condition Monitoring’ (Eds: Jones,MH; Guttenberger,J; Brenneke,H) Pineridge Press Ltd, Swansea,  pp199-224. 

6.
AU:
Fletcher,A. 

TI:
Honour reputation and officeholding in Elizabethan and Stuart England 

ED:
Fletcher,A. & Stevenson,J.

BK:
Order and disorder in early-modern England 

PU:
Cambridge: University Press 

YR:
1985

Thesis

7.
Mutch,A. Rural Society in Lancashire 1840-1914. Manchester Ph.D. thesis, 1980

Appendix B  Keyboard shortcuts

Although these “hot keys” are for use primarily in data entry and editing, they can be used wherever relevant in other parts of the package. This applies mainly to F2 (Glossary key), F3/F4 (Copy/Paste), F5/F6 (delete part of field), and F10 (extended ASCII).

F3 and F4 can be particularly useful under Windows, as they use the Windows clipboard. Thus F3 can copy any Papyrus item to the clipboard from which it can be pasted into another program, F4 can copy into a Papyrus field, text put into the clipboard by another program.

F7 and F8 are useful when entering a series of chapters from the same book.

Esc 
Cancel all changes made to the entry.

Alt/S 
Save the changes made to the entry




Enter, Tab
Move down to next field

Shift/Tab
Move up to previous field

Home
Move cursor to start of field

End
Move cursor to end of field

PgUp, Ctrl/Home
Move to first field

PgDn, Ctrl/End
Move to last field




Insert
Toggle between Insert & Overtype modes

Ctrl/Enter
Insert a paragraph break (for Comments etc)

F2, Ctrl/G
Look Up Glossary/Keywords/Authors/etc

F3 / F4
Copy/Paste current field

F5, Ctrl/B
Erase Backwards from cursor to start

F6, Ctrl/F
Erase Forwards from cursor to end

F7, Ctrl/A
Copy all the fields of the last-saved reference of this type

F8, Ctrl/L
Copy the contents of the current field from the last-saved reference of this type

F9, Ctrl/R
Restore answer

F10, Ctrl/E
Extended ASCII character

Alt/H (toggle)
Show/Hide the Hidden fields

Appendix C  Installing the example database

If working outside the Computing Service training rooms the example database used in this document should be copied onto the computer you are using.  If you have difficulty following these instructions consult your department’s Computer Support Person.

Copying the example database

Warning:  Under no circumstances copy the example Papyrus database into a directory that already contains a Papyrus database.  It is safest to create a new (empty) directory to hold the example database.


Use NT Explorer create a new directory (eg C:\PAPEX).

If the example database is on floppy disk:

Use NT Explorer to copy all files supplied with the example database into this empty directory.

If the example database is to be obtained from the University’s ‘anonymous ftp server’:


Download the file PAP-T1.ZIP (in the directory /PUB/INFO/TUTORIALS) into the empty directory.  Then unpack the ZIP file using a suitable unpacker, such as UNZIP.EXE or similar (obtainable from the ‘anonymous ftp server’ in directory /PUB/IBMPC/UNPACKERS).

Using the example database

Papyrus needs to be told the name of the directory that contains the example database.


Start Papyrus.  If this is the first time Papyrus has been used you may be asked if you want to create a fresh database.  Answer Y to this question then confirm that you want a ‘system initialisation’ by typing Y when asked ‘Are you sure?’.


When the Main menu is displayed, click on diRectory or type R.

When asked to specify a data directory, use the Backspace key to delete the displayed directory name.  Then type the name of the directory containing the example database (eg C:\PAPEX).


This document assumes that the example database is in the directory F:\USER\PAPYRUS.  If it is in a different directory then substitute the name of your directory each time you see F:\USER\PAPYRUS.

If working on the example database over several sessions, repeat the instructions in this section at the start of each session.


